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AXMEDIS COPYRIGHT NOTICE 

The following terms (including future possible amendments) set out the rights and obligations licensee will be requested to accept 

on entering into possession of any official AXMEDIS document either by downloading it from the web site or by any other means. 

Any relevant AXMEDIS document includes this license. PLEASE READ THE FOLLOWING TERMS CAREFULLY AS THEY HAVE TO BE 

ACCEPTED PRIOR TO READING/USE OF THE DOCUMENT. 

1. DEFINITIONS 

i. "Acceptance Date" is the date on which these terms and conditions for entering into possession of the document 

have been accepted.  

ii. "Copyright" stands for any content, document or portion of it that is covered by the copyright disclaimer in a 

Document.  

iii. "Licensor" is AXMEDIS Consortium as a de-facto consortium of the EC project and any of its derivations in terms of 

companies and/or associations, see www.AXMEDIS.org 

iv. "Document" means the information contained in any electronic file, which has been published by the Licensor’s as 

AXMEDIS official document and listed in the web site mentioned above or available by any other means.  

v. "Works" means any works created by the licensee, which reproduce a Document or any of its part.  

2. LICENCE  

1. The Licensor grants a non-exclusive royalty free licence to reproduce and use the Documents subject to present 

terms and conditions (the Licence) for the parts that are own and proprietary property the of AXMEDIS consortium 

or its members. 

2. In consideration of the Licensor granting the Licence, licensee agrees to adhere to the following terms and 

conditions.  

3. TERM AND TERMINATION  

1. Granted Licence shall commence on Acceptance Date.  

2. Granted Licence will terminate automatically if licensee fails to comply with any of the terms and conditions of this 

Licence.  

3. Termination of this Licence does not affect either party’s accrued rights and obligations as at the date of 

termination.  

4. Upon termination of this Licence for whatever reason, licensee shall cease to make any use of the accessed 

Copyright.  

5. All provisions of this Licence, which are necessary for the interpretation or enforcement of a party’s rights or 

obligations, shall survive termination of this Licence and shall continue in full force and effect.  

6. Notwithstanding License termination, confidentiality clauses related to any content, document or part of it as stated 

in the document itself will remain in force for a period of 5 years after license issue date or the period stated in the 

document whichever is the longer. 

4. USE  

1. Licensee shall not breach or denigrate the integrity of the Copyright Notice and in particular shall not:  

i. remove this Copyright Notice on a Document or any of its reproduction in any form in which those may be 

achieved;  

ii. change or remove the title of a Document;  

iii. use all or any part of a Document as part of a specification or standard not emanating from the Licensor 

without the prior written consent of the Licensor; or  

iv. do or permit others to do any act or omission in relation to a Document which is contrary to the rights and 

obligations as stated in the present license and agreed with the Licensor  

5. COPYRIGHT NOTICES  

http://www.axmedis.org/
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1. All Works shall bear a clear notice asserting the Licensor’s Copyright. The notice shall use the wording employed by 

the Licensor in its own copyright notice unless the Licensor otherwise instructs licensees.  

6. WARRANTY  

1. The Licensor warrants the licensee that the present licence is issued on the basis of full Copyright ownership or re-

licensing agreements granting the Licensor full licensing and enforcement power.  

2. For the avoidance of doubt the licensee should be aware that although the Copyright in the documents is given 

under warranty this warranty does not extend to the content of any document which may contain references or 

specifications or technologies that are covered by patents (also of third parties) or that refer to other standards. 

AXMEDIS is not responsible and does not guarantee that the information contained in the document is fully 

proprietary of AXMEDIS consortium and/or partners.  

3. Licensee hereby undertakes to the Licensor that he will, without prejudice to any other right of action which the 

Licensor may have, at all times keep the Licensor fully and effectively indemnified against all and any liability (which 

liability shall include, without limitation, all losses, costs, claims, expenses, demands, actions, damages, legal and 

other professional fees and expenses on a full indemnity basis) which the Licensor may suffer or incur as a result of, 

or by reason of, any breach or non-fulfillment of any of his obligations in respect of this License.  

7. INFRINGEMENT  

1. Licensee undertakes to notify promptly the Licensor of any threatened or actual infringement of the Copyright which 

comes to licensee notice and shall, at the Licensor’s request and expense, do all such things as are reasonably 

necessary to defend and enforce the Licensor’s rights in the Copyright.  

8. GOVERNING LAW AND JURISDICTION  

1. This Licence shall be subject to, and construed and interpreted in accordance with Italian law.  

2. The parties irrevocably submit to the exclusive jurisdiction of the Italian Courts. 

Please note that: 

 You can become affiliated with AXMEDIS. This will give you the access to a huge amount of knowledge, information and 

source code related to the AXMEDIS Framework. If you are interested please contact P. Nesi at nesi@dsi.unifi.it. Once 

affiliated with AXMEDIS you will have the possibility of using the AXMEDIS specification and technology for your business.  

 You can contribute to the improvement of AXMEDIS documents and specification by sending the contribution to P. Nesi 

at nesi@dsi.unifi.itYou can attend AXMEDIS meetings that are open to public, for additional information see 

WWW.AXMEDIS.org or contact P. Nesi at nesi@dsi.unifi.it 

 

COPYRIGHT 

Copyright © 2008 by AXMEDIS 

For information on this book, contact: 

Prof. Paolo Nesi 

Via S. Marta 3 

50136 Firenze (Italy) 

Tel: +39 055 4796523 

Fax: +39 055 4796469 

http://www.axmedis.com 

To report errors, please send a note to mitolo@dsi.unifi.it  

mailto:nesi@dsi.unifi.it
mailto:nesi@dsi.unifi.it
http://www.axmedis.org/
mailto:nesi@dsi.unifi.it
http://www.axmedis.com/
mailto:mitolo@dsi.unifi.it
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INTRODUCTION 

Dear AXMEDIS User, 
 
Welcome to the AXMEDIS DRM Editor and Viewer User Manual. 

With this guide, the AXMEDIS team is hoping to help users to view, edit and manage MPEG-21 REL licenses. 

AXMEDIS is a very complex and complete world and it is very difficult to cover all the aspects in only one manual. For 
other parts of the AXMEDIS Framework please check the links and references given at the end of this manual. 

Remember to not hesitate to contact the AXMEDIS team if you need additional information or to point out mistakes in 
this manual. Also do not hesitate to visit the AXMEDIS portal where you can find much other information regarding 
the AXMEDIS technology, with many real examples and objects. 

OVERVIEW 

This document aim is to describe the User Manual of the DRM Editor and Viewer. The main functionalities of DRM 
Editor and Viewer are: 

o Parse MPEG-21 REL (Rights Expression Language) Licenses. MPEG-21 REL is a complex standard, and its full 
implementation has nowhere reported to be done. The following limitations apply to this tool: 

 Only these four conditions, found in the standard extension of MPEG-21 REL, have been defined: Territory, 
Term, Number and Fee, while all the rights in the multimedia extension can be used. 

 Distribution licenses (those with an Issue right) should not hold more grants apart of the issue grant itself at 
the root level. The number of issued grants can be as big as 8. AXMEDIS platform only uses one level of 
nesting in distribution licenses (i.e. one for distributor that allows him the distribution to final users). 
Nevertheless, the application allows an arbitrary nested number of levels for the distribution chain in case 
they are needed.  

 Up to 8 grants per license are permitted (although the standard does not limit this number) 
o Load licenses from XML files and store in files. Licenses can be serialized in XML files. 
o  Load licenses from AXMEDIS License database and Store licenses remotely. Licenses can be stored/retrieved 

from the AXMEDIS License database, through the PMS Server. 
o Search of grants in the license. 
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INTRODUCTION TO MPEG-21 REL  

A MPEG-21 REL License is an electronic document by which one AXMEDIS user gives certain rights to other AXMEDIS 

user over a certain resource (usually an AXMEDIS object). These rights can be conditioned upon the satisfaction of one 

or more restrictions. Multimedia content conveyed in AXMEDIS objects can thus be protected and distributed safely 

between the AXMEDIS community.  

“DRM Editor and Viewer” is the software application to view and eventually edit these MPEG-21 REL Licenses. This 

user manual refers to its version 2.4. “DRM Editor and Viewer”, and it will describe all the needed information to 

install and operate the application. 

KINDS OF MPEG-21 REL LICENSES 

The licensing procedure is tightly bound to the concepts of Intellectual Property, and through the life-cycle of an 

AXMEDIS object different licenses will be in use. The three major steps have their own kind of license: 

o Potential Available Right (PAR). A Potential Available Right is a license addressed to no one in particular, it comes 
embedded in an AXMEDIS object and it allows the creator to restrict the licensing modalities over its object. The 
AxEditor tool, described in other manuals, is used to create, view and edit AXMEDIS objects, and one of its panels 
permits editing Potential Available Rights which will come within the AXMEDIS object. PARs can be either internal 
or external, depending on whether they are publicly exposed or not.   

o Distribution License. Once the AXMEDIS object has been created and registered, it can be given for its 
distribution. To do that, a distribution license has to be issued. A distribution license is a standard license by which 
one user gives the other user the right to issue more licenses (eventually, revoke and obtain, too). Therefore, any 
license containing an issue (or revoke) right is called a distribution license. Distribution licenses can be arbitrarily 
nested, and it is possible to give the right to give the right to issue licenses. Nesting  levels are unlimited, though 
in practice these features will very seldom be used. The creation of a distribution license should match the 
Potential Available Rights associated to the referred object. 

o User License. Or end-user licenses are those MPEG-21 REL licenses holding no issue or revoke right. They are 
intended to be given by a distributor for the use of general users.  

 

SOME TERMINOLOGY 

For those AXMEDIS users not familiar with the MPEG-21 REL standard, we offer here some informal definitions: 

o Issuer. The (AXMEDIS) user who yields rights to another (AXMEDIS) user. 
o Principal. The (AXMEDIS) user who benefits from the rights given in the license. 
o Resource. The (AXMEDIS) object over which the rights are given. 
o Right. Set of defined actions that can be conceded to operate on an object. 
o Condition. Logical statement that can be either true or false, and whose satisfaction is required to execute a right. 
o Grant. Conceptual unit of concession, it comprises one right and zero or more conditions. 
o Grant group. Group of grants. 
o Authorization. Process by which a given user, in a given context (its location and the current time), is checked to 

have a certain right over a certain resource. 
o Fee. Condition imposed about payment. AXMEDIS does not verify payments. 
o Territory. Condition imposed about the location where a right in a grant can be executed. AXMEDIS verifies this 

condition before allowing a user to exercise a certain right. 
o Interval. Condition imposed about the time when a right in a grant can be executed. AXMEDIS verifies this 

condition. 
o Number. Of times that a certain right can be executed. AXMEDIS carries an account so that this condition can be 

verified. 
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DRM EDITOR AND VIEWER INSTALLATION 

APPLICATION MODALITIES 

The DRM Editor and Viewer can view and edit with the same interface the three kinds of licenses referred in the 

previous sections. However, as PAR´s are to be stored within the object, its edition is integrated in the AXMEDIS Editor 

application. Thus, we can access the functionalities: 

o Integrated in the AXMEDIS Editor. To create PAR´s, the panel called “DRM Editor” will offer all the functionalities 
except assigning a principal and specifying the issuer.  

o Launched as a Standalone Application. From the Start Menu of Windows (or the corresponding link in other 
platforms), in the drm-tools folder, the DRM Editor can be launched. Additionally, it can be launched from the 
AXMEDIS Editor, in the menu entry “Launch license editor...” which appears when the DRM panel has been 
selected. 

“DRM Editor and Viewer” or simply “DRM Editor” allows viewing and editing the licenses. Eventually, it might be of 

use distributing an application merely to view the license, and having suppressed the editing functionality. Such an 

application, called “DRM Viewer” can come bundled with the installation package; its features are exactly those of the 

DRM Editor but with no possibility of modifying or storing the licenses. 

PRE-REQUISITES 

No special requisites are required to install DRM Editor and Viewer, except an Internet connection to retrieve and 

store remotely the licenses. 

DRM EDITOR AND VIEWER STANDALONE SETUP 

The “DRM Editor and Viewer” is distributed with the drm-tools package. To set it up, it is only required to follow the 

easy steps of a standard installation application, but afterwards a registration procedure has to be accomplished. 

This registration procedure consists of two steps: 

o User registration. The user of the tool has to be registered in the AXMEDIS platform. To do this, the user must 
obtain a User Certificate in the AXMEDIS Registration Portal

1
. The application (either the AXMEDIS Editor or the 

AXMEDIS DRM Editor and Viewer as standalone application) will prompt for the certificate file (it is a .p12 file, a 
PKCS12 file). 

o Tool certification. Once the tool has been installed, AXMEDIS requires the warranty that the tool is running 
always in the same machine and associated to the user. The tool itself is certified to prevent that malicious 
software pretends to be AXMEDIS Software. To certificate the tool, the application will send internally AXMEDIS 
the user certificate, a device fingerprint and the tool certificate. 

The registration can be done from the File menu, Register tool.  

CONFIGURATION 

The edition of PARs from the AXMEDIS Editor is subject to the same terms of configuration like in the AXMEDIS Editor. 

                                                                 

1
 At edition time of this document, the URL was http://axcs.axmedis.org:8080/RegistrationPortal/. 
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The “DRM Editor and Viewer” standalone application fixes its configuration through a file called “drmev-

configuration.xml”. It has to be found in the same folder of the “drmeditor.exe”, and a sample file follows: 

<?xml version="1.0" encoding="UTF-8" standalone="no" ?> 

<Configuration xmlns="http://www.axmedis.org/configuration"> 

 <Module category="" id="DRMEV"> 
    <Parameter name="OnlyViewer" type="string">false</Parameter> 

    <Parameter name="TreeMode" type="string">false</Parameter> 

    <Parameter name="RELType" type="string">basic</Parameter> 
    <Parameter name="ReducedSet" type="string">true</Parameter> 

 </Module> 

 <Module category="" id="PMSCLIENT"> 
    <Parameter name="PMSClientEndpoint" type="string">https://axpms.axmedis.org:443/PMS</Parameter> 

 </Module> 

 <Module category="" id="CERTINFO"> 
  <Parameter name="USERNAME" type="string">usercer.p12</Parameter> 

  <Parameter name="USERPWD" type="string">00000000</Parameter> 

</Module> 
 <Module category="" id="DATABASE" visible="true"> 

    <Parameter name="user" type="string">axdbuser</Parameter> 
    <Parameter name="passwd" type="string">axmedis</Parameter> 

    <Parameter name="LoaderWSEndPoint" type="string">http://axdbf.axmedis.org:8080/LoaderSaverF/load</Parameter> 

    <Parameter name="SaverWSEndPoint" type="string">http://axdbf.axmedis.org:8080/LoaderSaverF/save</Parameter> 
    <Parameter name="FTPPath" type="string">ftp://axdbf.axmedis.org</Parameter> 

    <Parameter name="LockWSEndPoint" type="string">http://axdbf.axmedis.org:8080/LockUnlockWSF/lockunlock</Parameter> 

 </Module> 
 <Module category="" id="AXMEDIS_SELECTION"> 

    <Parameter name="MAIN_QUERY_SUPPORT_WSDL" 

type="string">http://axdbf.axmedis.org:8080/MainQuerySupportWSF/mqs?WSDL</Parameter> 
    <Parameter name="SELECTION_ARCHIVE_WSDL"/> 

 </Module> 

</Configuration> 

All the elements are optional as there is a default value, but the following elements require special attention: 

o In module DRMEV.  

 ReducedSet, if set to true, will make the DRM E&V more handy, offering a reduced set of four currencies and 
15 countries (those with a bigger economical activity, measured by the official GDP published by the World 
Bank).  

 RELType, basic by default, decides which set of rights are considered. If selected ‘extended’, rights from the 
MPEG-21 REL extensions will be also considered. 

 OnlyViewer, false by default, establishes if there can be editing capabilities or not.  

 TreeMode, false by default, shows an alternative tree-based interface 
o In module PMSCLIENT 

 PMSClientEndPoint, gives the PMS Server access point. 
o In module CERTINFO 

 Username, points at the user X509 certificate file issued by AXMEDIS. 

 Userpwd, points at the private password to open that certificate. If this parameter is not present, the user 
will always be prompted to introduce such password. It is strongly recommended not to use this element. 

o Modules DATABASE and AXMEDIS_SELECTION 

 They are considered for querying the AXMEDIS database etc., see other manuals for a complete reference. 

 

THE DRM EDITOR AND VIEWER APPLICATION 

INTERFACE ELEMENTS 

The main window shows two areas: in the left a hierarchically structure is displayed (also called tree), which is used to 

navigate through the license elements; in the right side there is a panel showing information related to the element 

marked in the tree. Functionalities can be accessed through the menu options, the buttons in the button bar, or the 

buttons that appear in the panel. The buttons do not appear when editing PARs in the AXMEDIS Editor application, as 

well as some menu entries. 



AXMEDIS DRM Editor and Viewer User Manual 

 

 

Se
ct

io
n

: 
TH

E 
D

R
M

 E
D

IT
O

R
 A

N
D

 V
IE

W
ER

 a
p

p
lic

at
io

n
 

10 

 

OPERATING WITH THE APPLICATION 

 

o Run the DRM Editor and Viewer standalone version by clicking in the Start Menu in DRM E&V. Note that two 
instances of the application cannot run at the same time. 

o Register the application. The application as it comes is useless if you are not registered. The first step, to be done 
only once, consists of the following steps: 

 Visit the AXMEDIS Registration Portal, fill the fields in, and you will retrieve a license, under the form of X.509 
certificate, a file with extension .p12. 

 Click in “File->Register tool”, and introduce the path to this file when prompted. 

 The application will also send data information about your computer and your software (Some 
antivirus/firewalls may complain but AXMEDIS is no malware). 

 You will be asked if you want your password to be stored permanently in your computer. This will accelerate 
your use of the tools, as it will not be demanded any more, but if the computer is not reliable you will be 
compromising your security. 

 After the process, you should get a message similar to this one:  

 

Figure 1. User and tool identifiers after registration 

 
These long numbers are your identifiers, both of the user and the tool (of course their exact values will be 
different from Figure 1). 
 

o Open a license from a file  (see Figure 2). The panel displays the file path or an alternative description. 

 

Figure 2. The AXMEDIS DRM Editor and Viewer 
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o Or create a new license . When a new license is created, it is empty. The tree appears with an “issuer” 
element and with a “Grant Group” element. They are initially empty.  

o Edit the license.  

 When the tree is clicked on its “issuer element”, the Editor shows the issuer panel (see Figure 3 ). The 
“issuer” can be set to an arbitrary string (clicking in the menu “Edit->Set Issuer Text…”) or can be set to the 
default registered user (“Edit->Set yourself as the user”). The issuer date cannot be set but it is an important 
parameter, fixed by the AXMEDIS servers at issuance time.  

 

 

Figure 3. Issuer element 

 

 When the tree is clicked on its “GrantGroup element”, a Grant Group panel is displayed (see Figure 3). From 

this panel it is possible to add  or delete  grants. The first icon creates an empty grant, the second 
deletes it. Once a grant has been created, it will be displayed in the tree. 

 Expand and collapse the license tree by using the buttons  and . 
.  
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Figure 4. DRM E&V Grant group edition 

o Editing the Grant. When the tree is clicked on its “Grant” element (see Figure 5), the Grant panel is shown. From 
this panel, the following actions can be performed: 

 To change the following fields: principal, right, resource. 

 To add  and remove  conditions. The conditions that can be set are: number, interval, territory 
and/or fee. Each of them can be modified.  

 

 

Figure 5. DRM E&V Grant view 

 When the issue right is chosen, the license becomes a “distributor license”, and the Grants underneath are 
Grants to be given by the distributor. This is reflected in the tree, where a new sublevel is displayed 
containing additional grants.  
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o Store a license to a file. This option is performed when selection the “File -> Save to File” option of the Editor. It is 
advised to store the licenses in the given folder. Or in any other directory, containing a “schemas” folder with the 
given XML Schemas, if we want the license to be validated. 

o Store a license into a remote server . Sends the license to the corresponding server. The license is validated 
before it is stored in the server’s database. 

 
 

THE DRM EDITOR AND VIEWER IN THE AXMEDIS EDITOR APPLICATION 

 
The DRM Editor and Viewer embedded in the AXMEDIS Editor Application is used to insert PARs in the AXMEDIS 
objects at editing time. It lacks the menu bar and the toolbar, but has the next following features: 

 Set PAR URL 

 Set PAR Status 
 
No principals can be specified (this is the defining feature of a PAR). 
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APPENDIX: THE CONTRACTS EXTENSION 

INTRODUCTION 

Essential information in narrative audiovisual contracts can be mapped into licenses. But to meet some specific needs 

of this sector, the specification of MPEG-21 REL to write licenses has proved not to be enough. 

To repair such situation, an extension of the MPEG-21 REL has been written able to cover those spots where the 

standard was insufficient. The resulting application, the “Contract Manager”, has been integrated with the AXMEDIS 

DRM Editor and Viewer. The following extensions to the MPEG-21 REL standards have been done: 

NEW RIGHTS 

Besides the standard rights defined in the Multimedia Extension of MPEG-21 REL, the following rights have been 

introduced: 

 Translate. To render in another language 

 Dub. To insert a new soundtrack, often a synchronized translation of the original dialogue, into (a film).  

 Reproduce. To authorize the act of reproduction of content in any manner or form (i.e. reproduction covers 

all methods of reproduction for instance drawing, lithography, offset and other printing processes, 

photocopying, recording). 

 Perform. A performance is considered "public" when the work is performed (presented or executed) in a 

place open to the public or at a place where a substantial number of persons outside of a normal circle of a 

family and its social acquaintances are gathered. 

 Transmit. To send data over a communications line 

 Broadcast. To send out or communicate, especially by radio or television. 

 Publish. To prepare and issue for public distribution or sale. 

 Record. To register (sound or images) in permanent form by mechanical, electrical or electronic means for 

reproduction 

 Remix. To recombine (audio tracks or channels from a recording) to produce a new or modified audio 

recording 

 Promote. To attempt to sell or popularize by advertising or publicity, using the image rights of the artist.  

Right aimed at optimizing the exploitation of the licensed content making reference to the artist and to its 

image. 

 Synchronize. To cause (soundtrack and action) to match exactly in a film 

The addition of these rights is as straightforward as with the rest of the MPEG-21 REL rights. 

NEW CONDITIONS 

Apart from the MPEG-21 REL conditions (defined in the Standard Extension), the following conditions have been 

added: 
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 Attribution. Through the use of the m3x:copyrightNotice condition (present in the Open Access Extension), it 

is achieved the restriction that derived works must include an acknowledgement text, defined by the creator. 

 validityPeriodRenew. With this condition, it can be expressed that the interval of validity of a certain license 

can be extended for a certain period of time, upon payment of a certain amount before a certain deadline. 

 feeFlatExt. With this condition, it is possible to specify the payment with a free text, in another medium 

different from money (for example stocks of the company, etc.). 

 Exclusivity. Written here as a condition, it obliges the issuer not to redistribute a certain piece among more 

artists. 

 nonTerritory. This condition will facilitate a lot the redaction of grants where the valid territory is the entire 

universe except the shown domains. 

OASIS E-CONTRACT IN THE LICENSE 

By using this software, the text of contract will be inserted in the license. Note that sometimes contracts include 

images, or tables, and this information may be dropped. But the rest of the contract, the textual part, will be 

processed, formatted in the OASIS e-Contracts format and stored in the license (in the otherInfo field).  

This field can be seen with the DRM Editor and Viewer Application. 

INSTALLATION 

To install the Contract Manager application, just follow the installer application. Manual installation is as simple as 

leaving the file “MPEG21Wizard.dll” and “WordReader.dll” in the same folder where the drmeditord.exe lies. 

 The AXMEDIS DRM Editor and Viewer now will be able to deal with the new rights and conditions.  

 A new Wizard will appear, to facilitate the task of writing licenses from contracts. This Wizard can be called 

from the “Edit” Menu. 

USE OF THE CONTRACTS-ENABLED DRM EDITOR AND VIEWER 

Operation with these new elements is as simple as with the others. The Figure 6 shows all the possible conditions at 

the same time. 

o The Interval is the period when the right can be exercised. On its right, there are four fields to fill up: 

 The period for which the license will be extended (number of units, units (day/month/year)) 

 The payment that has to be done (amount, currency) 

o The copyright notice can be added by clicking in the standard Creative Commons for attribution:  Being 
possible the addition of a free text. Leaving it in blank, it will lead to the removal of this condition. 

o Extended flat fee can be selected as one entry more in the Fee condition control. 
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Figure 6. DRM E&V Showing a license with many conditions 

 

USE OF THE CONTRACTS WIZARD 

The contracts wizard is launched from the AXMEDIS DRM Editor and Viewer application, from the “Edit-

>CreateFromContract” entry. This is a wizard-like application, to facilitate the creation of licenses from contracts and 

whose result will be a license to be further edited in the DRM Editor.  

CONTRACT SELECTION 

In the first step, a contract is requested.  
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Figure 7. Opening a contract 

Accepted formats are:  

 Text files. Both in UNIX and MS-DOS encoding 

 PDF files. 

 Microsoft Word 2003 files. 

Once the contract is open, it suffers some pre-processing, and the contract is then analyzed. The result of such 

analysis is shown in the next screen, designed to host more information but which initially dumps some results of the 

analysis. If the document was not recognized as a contract, the wizard will go no further. 

 

Figure 8. Analysis result 

 PARTIES SELECTION 

Immediately after, the parties of the contract are identified as the Issuer and the Principal of the license. The upper 

part shows the clause that an automatic scanning has detected to be the clause with the parties. This clause is usually 

well recognized and helps the user acknowledging the issuer and the principal. 
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Figure 9. Parties selection 

 

There are two empty fields, where the licensor and the licensee should go, that should contain their AXMEDIS User 

identifier. This information is not available for this application, so even knowing a common name from the contract, 

there is no possibility of automatically guessing it. Yet, what is possible, is checking that a given AXMEDIS user 

identifier (AXUID) exists, and thus for such checking there are two buttons provided. Each of the users may take a role 

of “EndUser” or “Distributor”. “Distributor” to “EndUser” generates an end user license, while a “Distributor” to 

“Distributor” generates a distribution license. If the application is ontology enabled, this information will be also 

confirmed to be true. An additional button will drive the user to the AXMEDIS Registration portal. 

RESOURCE SELECTION 

After this step, the resources of the license have to be chosen. There are several possibilities for this. 

 

Figure 10. Resource selection 
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 From an AXMEDIS object file. By clicking this , a file will be able to be selected. Multiple files can be 

selected 

 From the AXMEDIS object database.  

 The resource given as a free text (representing an identifier surely)  

More than one resource can be chosen, and they will be displayed in the list. Each added resource can be suppressed 

too later on. 

TERM SELECTION 

The term is the period when the rights can be exercised. Again, a hint clause is given in the upper side of the wizard. 

The period is given by two dates (no hours and minutes can be selected).  

 

Figure 11. Term selection 

Additionally, the period can be extended for a given period upon payment of a given amount. All of this can be chosen 

in this panel. The condition can be suppressed with the button . 

TERRITORY SELECTION 

Territory can be selected from the next screen. It can be chosen a country (“Italy”, for example), a region within the 

country (“Italy, Roma”), the universe (worldwide licensing), or the universe excepting a country. 
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Figure 12. Territory selection 

RIGHTS SELECTION 

Finally, a rights selection is made. Some rights can be granted under exclusivity terms, and some can be given with an 

attribution condition, by which a derived work must include a certain text provided by the original creator. 

 

Figure 13. Rights selection 

The result of this process will be loaded into the DRM Editor and Viewer, from where it will be possible to store the 

license or to send it to the AXMEDIS License database, etc. 
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REFERENCES AND LINKS 

AXMEDIS TUTORIALS  

o General Tutorial and Overview (November 2007, Barcelona, Spain)  

 PPT: http://www.axmedis.org/documenti/view_documenti.php?doc_id=3653 

 Video on part 1  

 Video on part 2  

 Video on part 3  

 Video on part 4  

 Video on part 5  

 Video on part 6  
o Content Production Tutorial (AXMEDIS 2007 Conference)   

http://www.axmedis.org/documenti/view_documenti.php?doc_id=3869  
o Content Distribution Tutorial (AXMEDIS 2006 Conference)   

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2666 
o Content Processing Tutorial (AXMEDIS 2006 Conference)    

http://www.axmedis.org/documenti/view_documenti.php?doc_id=3868 
o Workflow Tutorial (AXMEDIS 2006 Conference)   

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2652 
o AXMEDIS general overview and content production tutorial, March 2008 

 

AXMEDIS TOOLS FOR FREE DOWNLOAD 

o General download page: http://www.axmedis.org/documenti/documenti.php  
o AXMEDIS  content production tools include: 

http://www.axmedis.org/documenti/view_documenti.php?doc_id=3722   
Free Download of AXMEDIS Content Production Tools (editor and GRID AXCP tools, PnP, DRM editor, etc.), all 
what you need to create AXMEDIS objects and process any kind of content automatically: SMIL, HTML, MPEG-21, 
content adaptation,, fingerprint, crawling, indexing, cms, search, retrieval, control of P2P, etc. and much more. 
See documentation included 

o AXMEDIS players for PC:  
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3715  
AXMEDIS PC player version 1.2 January 2008. Free download, AXMEDIS player, MPEG-21 player, cross media 
player, SMIL, HTML, MPEG-4 ,etc 

o AXMEDIS multiskin player for PC: 
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3716 
AXMEDIS MultiSkin PC player version 1.2 january 2008. Free download, AXMEDIS player, MPEG-21 player, cross 
media player, SMIL, HTML, MPEG-4, with different skins available. 

o AXMEDIS Active X Player for PC for Web Pages, AXMEDIS .Net Player, MPEG-21 player, SMIL, HTML, MPEG-4, 
cross media, more than 200 file formats: 
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3717 

o  AXMEDIS player plus EUTELSAT OPENSKY client integrated 
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3767  

o AXEPTools: P2P client tool for establishing connection with the AXMEDIS P2P B2B network as Business User: 
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3840   

o AXMEDIA: P2P client tool for establishing connection with the AXMEDIS P2P B2B network as final users: 
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3841  

o AXMEDIS PDA player for Windows Mobiles 5 and 6:  
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3842  
It is capable to play AXMEDIS objects based on SMIL, HTML, video, audio, MPEG-4 files, etc. AXMEDIS PDA player 
for AXMEDIS MPEG-21 content including resources with presentations layer based on MPEG-4, HTML and SMIL 
Unzip the file, copy the CAB file and execute it on the PDA 

o Collection of Objects for AXMEDIS player for PDA (Jan 2008): 
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3748  
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http://www.axmedis.org/documenti/view_documenti.php?doc_id=3862
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3863
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3864
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3865
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3866
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3867
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3869
http://www.axmedis.org/documenti/view_documenti.php?doc_id=2666
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3868
http://www.axmedis.org/documenti/view_documenti.php?doc_id=2652
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3850
http://www.axmedis.org/documenti/documenti.php
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3722
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3715
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3716
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3717
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3767
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3840
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3841
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3842
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3748
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AXMEDIS TECHNICAL NOTES 

o AXMEDIS Content Model and Tools, Authoring Tools, Players for MPEG-21, PC, PDA, Mobile, STB, PVR, HDR, etc. 
(in English)  

o AXMEDIS Content Model and Tools, Authoring Tools, Players for MPEG-21, PC, PDA, Mobile, STB, PVR, HDR, etc. 
(in Italian) 

o AXMEDIS Content Processing GRID all features listed (in English) 
o AXMEDIS Content Processing GRID Tutte le caratteristiche descritte (in Italian) 
o AXMEDIS P2P Controlled network all features listed with cases (in English) 
o AXMEDIS P2P Controlled network tutte le caratteristiche, con alcune casistiche (in Italian) 
o AXMEDIS DRM, MPEG-21 DRM, Interoperable DRM (in English)  
o AXMEDIS DRM, MPEG-21 DRM, DRM interoperabile (in Italian) 
o Technical note on how to integrate the AXMEDIS DRM into an e-commerce portal and content distribution 

solution for content on demand and subscription 
o Come integrare AXMEDIS DRM in un portale per la distribuzione di contenuti digitali (in Italian) 
o AXMEDIS Show Case, AXMEDIS Mpeg-21 Content distribution via datellite dta broadcast, EUTELSAT OPENSKY 
o Technical note on the ELION AXMEDIS content on demand trial and solution, how to exploit AXMEDIS framework 

to create an cross media content distribution with DRM and automated production, and connection with P2P 
o Technical note on the TEO IPTV AXMEDIS trial and solution, how to exploit AXMEDIS framework to create an IPTV 

with DRM and automated production, and connection with P2P. 

AXMEDIS SOLUTIONS 

o Content Management Automation, AXCP: 
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=94&Itemid=33 

o AXMEDIS controlled P2P: 
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=97&Itemid=34 

o AXMEDIS production tools and players: 
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=101&Itemid=35 

o AXMEDIS DRM, MPEG-21 DRM: 
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=99&Itemid=36 

o FAQs: http://www.axmedis.org/com/index.php?option=com_content&task=blogcategory&id=7&Itemid=73 
 

AXMEDIS SHOWCASES 

o Content Distribution to Licensed Domains via DVB-T and P2P (BBC) 
o Protected Video on Demand Distribution via P2P toward PC (Tiscali) 
o Protected Video on Demand (VOD) Distribution to PC (ELION) 
o Content Distribution via Satellite Data Broadcast (DVB-S) to PC and STB (EUTELSAT) 
o Content Distribution to Kiosks (ILABS) 
o Video on Demand (VOD) Distribution to Set Top Box (TEO) 
o Content Posting Tool, for Final User content production/publication/DRM (SIAE) 
o Variazioni: Enrichment of Cultural Content 
o AXMEDIS Content and Tools: Automatic Production 
o AXMEDIS Controlled P2P Network 

 

AXMEDIS FRAMEWORK SPECIFICATION 

o AXMEDIS Framework General aspects, Editor and Model 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1891 

o AXMEDIS Command Manager http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2686 
o AXMEDIS Object Manager and Protection Processor: 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1972 
o AXMEDIS Editor and Viewers: http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2213 
o AXMEDIS External Editors, Viewers and Players: 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2211 
o AXMEDIS Content Processing Area: 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1958 

http://www.axmedis.org/documenti/view_documenti.php?doc_id=3845
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3845
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3707
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3707
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3624
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3675
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3612
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3708
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3616
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3683
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3736
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3736
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3721
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3820
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3745
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3745
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3738
http://www.axmedis.org/documenti/view_documenti.php?doc_id=3738
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=94&Itemid=33
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=97&Itemid=34
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=101&Itemid=35
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=99&Itemid=36
http://www.axmedis.org/com/index.php?option=com_content&task=blogcategory&id=7&Itemid=73
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=113&Itemid=64&Itemid=45
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=70&Itemid=54
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=75&Itemid=46
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=73&Itemid=47
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=76&Itemid=49
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=72&Itemid=51
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=79&Itemid=50
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=78&Itemid=52
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=108&Itemid=62
http://www.axmedis.org/com/index.php?option=com_content&task=view&id=107&Itemid=63
http://www.axmedis.org/documenti/view_documenti.php?doc_id=1891
http://www.axmedis.org/documenti/view_documenti.php?doc_id=1891
http://www.axmedis.org/documenti/view_documenti.php?doc_id=2686
http://www.axmedis.org/documenti/view_documenti.php?doc_id=1972
http://www.axmedis.org/documenti/view_documenti.php?doc_id=2213
http://www.axmedis.org/documenti/view_documenti.php?doc_id=2211
http://www.axmedis.org/documenti/view_documenti.php?doc_id=1958
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o AXMEDIS External Processing Algorithms: 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2017 

o AXMEDIS CMS Crawling capabilities: 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1907 

o AXMEDIS Database and query support: 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1932 

o AXMEDIS AXEPTool and AXMedia Tools: 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2718 

o AXMEDIS Programme and Publication Tools: 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1885 

o AXMEDIS Workflow Tools: 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1883 

o AXMEDIS Certifier and Supervisor and networks of AXCS 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1952 

o AXMEDIS Protection Support 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1882 

o AXMEDIS Accounting and Reporting : 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1887 

o Definitions Terms tables links http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1388  
 
AXMEDIS reports on basic enabling technologies  
o Content Model and Managing, MPEG-21, authoring, etc. 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2324  
o Content indexing and querying: 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2436 
o Content processing, Composition and Formatting 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2374 
o Content sharing and Production on P2P: 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2454 
o Content Protection and Supervision http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2371 
o Content Distribution via Internet 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2451  
o Content Distribution via Mobile 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2442  
o Content Distribution via Satellite data broadcast 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2313 
o Usability issues 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2339  
o AXMEDIS vs DMP MPEG21 Analysis http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1063  
o AXMEDIS Framework Infrastructure, guidelines and some tools 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1391  
o AXMEDIS Framework Validation and integration 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2445 
 
Basic knowledge reports 
o User requirements http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1712   
o Use Cases http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1824  
o Test Case http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2023  
 
Content Modeling and Test Cases  
o Content Aspect Specification http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1389  
o Content Aspect Specification Appendix http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1670  
o Content for Test Cases and Validation http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1393   
o Content Selection Guidelines http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1390   
o Multilingual Guidelines and Technical Solutions 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1427   
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http://www.axmedis.org/documenti/view_documenti.php?doc_id=1885
http://www.axmedis.org/documenti/view_documenti.php?doc_id=1883
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http://www.axmedis.org/documenti/view_documenti.php?doc_id=1882
http://www.axmedis.org/documenti/view_documenti.php?doc_id=1887
http://www.axmedis.org/documenti/view_documenti.php?doc_id=1388
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http://www.axmedis.org/documenti/view_documenti.php?doc_id=2313
http://www.axmedis.org/documenti/view_documenti.php?doc_id=2339%20
http://www.axmedis.org/documenti/view_documenti.php?doc_id=1063
http://www.axmedis.org/documenti/view_documenti.php?doc_id=1063
http://www.axmedis.org/documenti/view_documenti.php?doc_id=1391
http://www.axmedis.org/documenti/view_documenti.php?doc_id=2445
http://www.axmedis.org/documenti/view_documenti.php?doc_id=1712%20
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o AXMEDIS Editorial Format Guidelines and basic examples 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1394  
 

AXMEDIS FRAMEWORK DEMONSTRATORS, CASES, TRIALS, FOR DISTRIBUTION ETC. 

o requirements and use cases of AXMEDIS ELTEO of the content distribution for DVB-T to STB of Telecom Lithuania, 
and content distribution of Telecom Estonia 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2978  

o requirements and use cases of the 4HOME take up, demonstrators of BBC, TI, SDAE, including domains, AXMEDIS 
for broadcasting, and OMA integration and distribution 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2976  

o Specification final version of Take up AXMEDIS ELTEO for Video on demand, STB, IPTV solutions based on 
AXMEDIS technology: http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=3096  

o Integrated CMS integration aspects: http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2853  
o Integrated prototype: automated content production and formatting: 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2939  
o Integrated Distribution on demand via Internet 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2951  
o Integrated distribution via satellite data broadcast: 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2954  
o Integrated distribution towards mobiles: 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2945  
o Integrated Distribution towards PDA via Kiosks: 

http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2944  
o Content Posting Portal, Content Posting for Final User publication, SIAE Trial presentation:  

 http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2922  

 http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2923  
o VARIAZIONI project portal: http://www.variazioniproject.org/  

 

BROCHURES AND PRESS CUTTING (A PART)  

o AXMEDIS Project Brochure 
http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2712 

o Annual Public Report (2007): http://www.axmedis.org/documenti/view_documenti.php?doc_id=3621  
o Annual Public Report (2006) http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=2471 
o Annual Public Report (2005)  http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1439  
o AXMEDIS Project Synopsis http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1668  
o Digital Media in Italy presentation http://www.AXMEDIS.org/documenti/view_documenti.php?doc_id=1669  

 

OTHER REFERENCES 

 ISO/IEC, ISO/IEC FDIS 21000-5 - Rights Expression Language. ISO/IEC JTC1/SC 29/WG 11/N5839. July 2003. 

 ISO/IEC, ISO/IEC FDIS 21000-6 - Rights Data Dictionary. ISO/IEC JTC 1/SC 29/WG 11/N5842. July 2003. 

 Iannella, R.: Open Digital Right Language (ODRL) Version 1.1. http://odrl.net/1.1/ODRL-11.pdf . August 2002. 

 Open Mobile Alliance (OMA), http://www.openmobilealliance.com/  

 OMA DRM Rights Expression Language version 2 (OMA DRM REL v.2), http://www.openmobilealliance.com/  

 ISO/IEC, Study of ISO/IEC FCD 21000-4 IPMP Components. ISO/IEC JTC 1/SC 29/WG 11/N7426. July 2005. 
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